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IMPORTANT INFORMATION

READ FIRST

• READ this user's manual before using this emulator product.

• KEEP the user's manual handy for future reference.

Do not attempt to use the emulator product until you fully understand its mechanism.

DEFINITION OF SIGNAL WORDS

CAUTION CAUTION used without the safety alert symbol indicates a
potentially hazardous situation which, if not avoided, may result
in property damage.

NOTE emphasizes essential information.
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Preface

The SH7055 E8000 Hitachi Debugging Interface (referred to as the HDI) is a software tool that
supports program development by using an emulator for the Hitachi microprocessor SH7055
(referred to as the emulator).

This manual is the Debugging Platform User’s Manual, which is a separate volume to the Hitachi
Debugging Interface User’s Manual, and describes the HDI functions and its usage.  Read this
manual and the following manuals before using the HDI.

For details on the emulator,

• SH7055 E8000 Emulator User’s Manual

• Description Notes on Using the PC Interface Board (HS6000EII01H)

• Description Notes on Using the PC Card Interface (HS6000EIP01H) for the E6000/E8000
Emulator

• Description Notes on Using the PCI Interface Board (HS6000EIC01H) for the E6000/E8000
Emulator

• Description Notes on Using the PCI Interface Board (HS6000EIC02H) for the E6000/E8000
Emulator

• Description Notes on Using the USB Adapter (HS6000EIU01H) for the E6000/E8000
Emulator

• Description Notes on Using the LAN Adapter (HS6000ELN01H) for the E6000/E8000
Emulator

• SH7055 E8000 Emulator Diagnostic Program Manual

For details on the related software manuals,

• Hitachi Debugging Interface User’s Manual

• Hitachi Embedded Workshop User’s Manual

• SuperH RISC engine C/C++ Compiler User’s Manual

• SuperH RISC engine Cross Assembler User’s Manual

• H Series Linkage Editor Librarian, Object Converter User’s Manual

• SuperH RISC Engine C/C++ Compiler, Assembler, Optimizing Linkage Editor User's
Manual
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For details on the SH7055-series microprocessor,

• SH7055 Hardware Manual

• SH7055 Programming Manual

Refer to section 2, Installation, for details on HDI installation.

In this user’s manual, the operating environment is assumed to be the English version
Windows® 95 on the IBM PC.

Notes: 1. Windows®, Windows® 95, Windows® 98, Windows® 98SE, Windows NT® 4.0,
Windows® Me, and Windows® 2000 are operating system names controlled by
Microsoft Corporation in the United States.

2. IBM PC is a registered trademark of International Business Machines Corporation.

3. Pentium® is a registered trademark of Intel Corporation.

4. Adobe®, Adobe logo, Adobe® Acrobat®, and Adobe Acrobat logo are the trademarks of
Adobe System Incorporated.

All product names and brand names used in this user’s manual are trademarks or registered
trademarks of each company.
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Section 1 Overview

1.1 Overview

The SH7055 E8000 Hitachi Debugging Interface (referred to as the HDI) promotes efficient
debugging of programs written in C/C++ or assembly language in the environment using the
emulator for the SH7055 microprocessor.

1.1.1 Features

The HDI has the following features:

• High-speed downloading of load module files.

• A comprehensive set of break functions, trace conditions, and functions to set or edit memory
maps are enabled by the HDI windows.

• Large-capacity trace information can be displayed (a maximum of 64-k bus cycles are
displayed on the window).

• Command line functions (command system for the HDI).
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1.2 Operating Environment

The HDI is provided on CD-R. The following shows the acceptable operating environments:

Table 1.1 Operating Environments

Item Operating Environment

Host computer Built-in Pentium® or higher-performance CPU (300 MHz or higher is
recommended);  IBM PC or compatible

OS Windows® 95, Windows® 98, Windows® 98SE, Windows® ME,
Windows NT® 4.0, or Windows®2000

Minimum memory capacity 32 Mbytes or more (twice the load module size or more is
recommended).

Display 800 x 600 (SVGA) or better resolution.

Hard disk capacity Installation disk capacity: 40 Mbytes or more.
Prepare enough area by taking the swap area into account (four-
times or more the memory capacity is recommended).

Corresponding interface ISA or PCI bus slot, PC card (PCMCIA), USB adapter, LAN adapter
(conforms to IEEE802.3, 10BASE-T/100BASE-TX)

A pointing device such as a
mouse

A pointing device such as a mouse that can be connected to the host
computer and can be used for each OS.

CD-ROM drive To install the E8000 emulator software or to refer to the user’s
manual.

Table 1.2 Combination of the OS and Acceptable Interface

PCI Interface
Board (PCI)

PC Card
Interface
(PCMCIA)

PC
Interface
Board (ISA)

LAN
Adapter
(LAN)

USB
Adapter
(USB)

Windows® 95 O O O O X

Windows NT® 4.0 O O O O X

Windows® 98 O O O O X

Windows® 98SE O O O O O

Windows® Me O O X O O

Windows® 2000 O O X O O

Note: O: Can be used.
X: Cannot be used.
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1.3 Configuration of the CD-R

The CD-R includes the E8000 emulator software and the user’s manual for SH7055 E8000
emulator. See table 1.3.

Table 1.3 CD-R Files

Directory Name File Name Contents Note

setup.exe Installer

System E8000.sys [*1] System program for the SH7055
E8000 emulator

System shdct705.sys [*1] Control program for the SH7055
E8000 emulator

System shcnf705.sys [*1] Configuration file for the
SH7055 E8000 emulator

System diag.sys [*1] Diagnostic and maintenance
program

System ipw.exe [*1] Interface software

System setup.cc [*1] Script file for automatic
installation (IPW)

Drivers\Pci\95 pcihei.inf Setup information (PCI) For Windows

95, Windows

98, Windows

98SE, and
Windows Me

Drivers\Pci\95 pcihei.vxd Virtual driver (PCI) For Windows

95, Windows

98, Windows

98SE, and
Windows Me

Drivers\Pci\Nt pcihei.sys System file (PCI) For Windows
NT

Drivers\Pci\2000 pcihei.sys System file (PCI) For Windows

2000

Drivers\Pci\2000 pcihei2k.inf Setup information (PCI) For Windows

2000

Drivers\Isa\Nt emulator.sys System file (ISA) For Windows
NT

Drivers\Pcmcia\95 ulepcc.inf Setup information (PCMCIA) For Windows

95, Windows

98, Windows

98SE, and
Windows Me
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Table 1.3 CD-R Files (cont)

Directory Name File Name Contents Notes

Drivers\Pcmcia\95 ulepcc.vxd Virtual driver (PCMCIA) For Windows

95, Windows

98, Windows

98SE, and
Windows Me

Drivers\Pcmcia\Nt ulepccnt.sys System file (PCMCIA) For Windows
NT

Drivers\Pcmcia\2000 ulepcc2k.sys System file (PCMCIA) For Windows

2000

Drivers\USB\ uleusb.inf Setup information (PCI) For Windows

Me, Windows

98SE, and
Windows 2000

Drivers\USB\ uleusb.sys System file For Windows

Me, Windows

98SE, and
Windows 2000

Drivers\Pcmcia\2000 ulepcc2k.inf Setup information (PCMCIA) For Windows

2000

Manuals\Japanese HS6400DIIW5SJ.
pdf [*2]

Hitachi Debugging Interface
user’s manual

PDF documents
in Japanese [*5]

Manuals\Japanese HS7055D8IW1SJ.
pdf [*2]

SH7055 E8000 Hitachi
Debugging Interface User’s
Manual

PDF documents
in Japanese [*5]

Manuals\Japanese HS7055EDD81HJ
(*)[*3].pdf [*2]

SH7055 E8000 Emulator
User’s Manual

PDF documents
in Japanese [*5]

Manuals\Japanese HS7055EDD81HJ-
ER(*)[*3].pdf [*2]

Errata for SH7055 E8000
Emulator User’s Manual

PDF documents
in Japanese [*5]

Manuals\Japanese HS7055TM81HJ(*)
[*3].pdf [*2]

Descriptive Notes on the
Diagnostic Program for the
SH7055 E8000 Emulator

PDF documents
in Japanese [*5]

Manuals\Japanese HS7055EBK81HJ(*)
[*3].pdf [*2]

SH7055 E8000 Evaluation
Chip Board HS7055EBK81H
User’s Manual

PDF documents
in Japanese [*5]

Manuals\English HS6400DIIW4SE.
pdf [*4]

Hitachi Debugging Interface
user’s manual

PDF documents
in English [*5]

Manuals\English HS7055D8IW1SE.
pdf [*4]

SH7055 E8000 Hitachi
Debugging Interface User’s
Manual

PDF documents
in English [*5]
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Table 1.3 CD-R Files (cont)

Directory Name File Name Contents Notes

Manuals\English HS7055EDD81HE
(*)[*3].pdf [*4]

SH7055 E8000 Emulator
User’s Manual

PDF documents
in English [*5]

Manuals\English HS7055EDD81HE-
ER(*)[*3].pdf [*4]

Errata for SH7055 E8000
Emulator User’s Manual

PDF documents
in English [*5]

Manuals\English HS7055TM81HE(*)
[*3] .pdf [*4]

Descriptive Notes on the
Diagnostic Program for the
SH7055 E8000 Emulator

PDF documents
in English [*5]

Manuals\English HS7055EBK81HE
(*)[*3].pdf [*4]

SH7055 E8000 Evaluation
Chip Board HS7055EBH81H
User’s Manual

PDF documents
in English [*5]

Pdf_read\Japanese Ar500jpn.exe Acrobat Reader™ 5.0
installer

Japanese
version

Pdf_read\English Ar500eng.exe Acrobat Reader™ 5.0
installer

English version

Notes: 1. Installed on your host computer by the installer.

2. This is the Japanese version of the manual. It cannot be installed by the installer.

3. (*) indicates a manual revision.

4. This is the English version of the manual. It cannot be installed by the installer.

5.  Use the Acrobat Reader™ to see PDF documents.



6



7

Section 2 Installation

2.1 Installation Procedures

Sections below describe the installation procedures when the HDI is used.

2.1.1 Installing the Acrobat® Reader

Acrobat® Reader 5.0 is required to view the online manual. Acrobat® Reader is provided on the
CD-R of this product. The installation of Acrobat® Reader is described below. If you have
already installed Acrobat® Reader, do not carry out this procedure.

1. Install the CD-R of this product in the CD-ROM drive.

2. Click [Run…] from the [Start] menu.

3. Specify Ar500eng.exe in Pdf_read\English directory in the [Run] dialog box (e.g.
D:\Pdf_Read\English\Ar500eng.exe) then click the [OK] button.

4. Install according to the instructions displayed in the screen.

2.1.2 Setting up the E8000 Emulator

For details on setting up the E8000 emulator, refer to section 3, Preparation before Use, in Part I
of the SH7055 E8000 Emulator User’s Manual in the CD-R. Note that the full content of the
emulator system disk which is referred to in the SH7055 E8000 Emulator User’s Manual is in the
system directory of the CD-R.

2.2 Setting Up with Windows® Operating Systems

The following describes the setup procedure for Windows® operating systems.

Since hardware is set up during installation, the installation procedure may differ according to the
operating system and interface used (ISA, PCI, USB, PCMCIA, or LAN). Proceed with
installation according to the procedures for the environment in use.

To connect the host computer to the emulator, either a PC interface board (HS6000EII01H), PCI
interface board (HS6000EIC01H and HS6000EIC02H), USB interface board (HS6000EIU01H),
PC interface card (HS6000EIP01H), or a LAN adapter (HS6000ELN01H) can be selected.

For details on the connection of the PC interface board (ISA bus specifications), refer to section
2.2.4, PC Interface Board Specifications (ISA Bus Specifications), and the user’s manual. For
details on other connections, refer to the related user’s manual.

To install the provided software, insert the CD-R in the CD-ROM drive. If there are any
applications running, exit from them before installing the software.
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Click [Run…] from the [Start] menu. The [Run] dialog box will be displayed. Enter
<Drive>:\setup.exe and click the [OK] button. <Drive> is the drive name of the CD-ROM drive.

Proceed with installation by following instructions provided by the install wizard.

2.2.1 Setting Up with Windows® 95, Windows® 98, Windows® 98SE, or Windows® Me

              Operating System

When Using the PCI Interface Board:

• Install the provided software. Select [PCI Card Driver] as the component.

• Exit the operating system, shut down the host computer, and turn off the power switch.

• Install the PCI interface board into the host computer.

• Turn on the host computer. Hardware will be acknowledged and driver installation will start
automatically.

• Select [Search for the best driver for your device] for driver installation, and select [Specify a
location] for the location.

• Specify <Drive>:\DRIVERS\PCI\95 for the location. <Drive> is the drive name of the CD-
ROM drive.

• Check that PCIHEI Rev 1 has been detected and complete driver installation.

When Using the PC Interface Card:

• Install the provided software. Select [PC Card Driver (PCMCIA)] as the component.

• Install the PC interface card into the host computer.

• Hardware will be acknowledged and driver installation will start automatically.

• Select [Search for the best driver for your device] for driver installation, and select [Specify a
location] for the location.

• Specify <Drive>:\DRIVERS\PCIMCIA\95 for the location. <Drive> is the drive name of the
CD-ROM drive.

• Check that E6000 PC Card has been detected and complete driver installation.

When Using the PC Interface Board:

• Refer to section 2.2.4, PC Interface Board Specifications (ISA Bus Specifications), and set the
operating system environment and install the ISA bus interface board.

• Install the provided software. Select [ISA Driver] as the component.

Note: The PC interface board cannot be used under Windows® Me.
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When Using the LAN Adapter:

• Install the provided software. Select [E8000 LAN Driver] as the component.

• Connect the LAN adapter to the local network and turn the LAN adapter on.

• Select [SH7055 E8000 Emulator Software]-[Tools]-[LAN Adapter Configuration] from
[Start]-[Programs] to start the LAN Adapter Configuration.

• Set the LAN adapter by LAN Adapter Configuration.

• Turn the LAN adapter off and connect the LAN adapter to the target network and turn the
LAN adapter on. In this procedure, LAN adapter must be turned off even when the network is
not changed.

Note: When using a LAN adapter that has already been set, it is unnecessary to set it again. Use
LAN Adapter Configuration to define only the host computer. For details on the usage of
the LAN Adapter Configuration, refer to the online help of the LAN Adapter
Configuration.

When Using the USB Adapter:

• Install the provided software. Select [E8000 USB Driver] as the component.

• Install the USB adapter into the host computer.

• Hardware will be acknowledged and the USB adapter will be automatically acknowledged.

• Select [Search for the best driver for your device] for driver installation, and select [Specify a
location] for the location.

• Specify <Drive>:\DRIVERS\USB for the location. <Drive> is the drive name of the CD-ROM
drive.

• Check that E8000/E6000 USB Adapter has been detected and complete driver installation.

Note: The USB adapter is not supported in Windows® 95 and Windows® 98.
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2.2.2 Setting Up with Windows NT® 4.0 Operating System

When Using the PCI Interface Board:

• Exit from the operating system, shut down the host computer, and turn off the power switch.

• Install the PCI bus interface board into the host computer.

• Turn on the host computer. Log-on as Administrator.

• Install the provided software. Select [PCI Card Driver] as the component.

• Restart the host computer.

When Using the PC Interface Card:

• Exit from the operating system, shut down the host computer, and turn off the power switch.

• Install the PC interface card into the host computer.

• Turn on the host computer. Log-on as Administrator.

• Install the provided software. Select [PC Card Driver (PCMCIA)] as the component. Check
the values specified for use by the PC interface card before the information is requested
during installation. Select and start [Programs]-[Administrative Tools (Common)]-[Windows
NT Diagnostics] from [Start]-[Programs] to check the current status of IRQ, I/O ports, and
memory in the resource panels, and set values that will not cause contention with other
devices. Required resources are as follows: one channel for IRQ, H’F bytes for I/O ports,
H’4000 bytes for use as memory.

• Restart the host computer.

Note: Default settings start all the drivers selected as [Drivers] components after the activation of
the host computer. When the host computer is activated without a given card or an
inappropriate driver is installed, it is not possible to start the given driver. The service
control manager informs the user of the error, but it causes no other problem.

When Using the PC Interface Board:

• Refer to section 2.2.4, PC Interface Board Specifications (ISA Bus Specifications), and set the
operating system environment and install the ISA bus interface board.

• Log-on as Administrator.

• Install the provided software. Select [ISA Driver] as the component.

• Restart the host computer.

When Using the LAN Adapter:

• Log-on as Administrator.

• Install the provided software. Select [E8000 LAN Driver] as the component.

• Connect the LAN adapter to the local network and turn on the LAN adapter.
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• Select [SH7055 E8000 Emulator Software]-[Tools]-[LAN Adapter Configuration] from
[Start]-[Programs] and start the LAN Adapter Configuration.

• Set the LAN adapter by LAN Adapter Configuration.

• Turn off the LAN adapter and connect the LAN adapter to the target network and turn on the
LAN adapter. Then LAN adapter must be turned off even when the network is not changed.

Note: When using a LAN adapter that has already been set, it is unnecessary to set it again. Use
LAN Adapter Configuration to define only the host computer. For details on the usage of
the LAN Adapter Configuration, refer to the online help of the LAN Adapter
Configuration.

Support of the USB Adapter:

The USB adapter is not supported in Windows NT.

2.2.3 Setting Up with Windows® 2000 Operating System

Support of the PC Interface Board:

The PC interface board is not supported in Windows 2000.

When Using the PCI Interface Board:

• Log-on as Administrator.

• Install the provided software. Select [PCI Card Driver] as the component.

• Exit from the operating system, shut down the host computer, and turn off the power switch.

• Install the PCI bus interface board into the host computer.

• Turn on the host computer. Hardware will be acknowledged and driver installation will start
automatically.

• Select [Search for a suitable driver for my device (recommended)] for driver installation, and
select [Specify a location] for the location.

• Specify <Drive>:\DRIVERS\PCI\2000 for the location. <Drive> is the drive name of the CD-
ROM drive.

• Check that E6000 PCI Card has been detected and complete driver installation.

When Using the PC Interface Card:

• Log-on as Administrator.

• Install the provided software. Select [PC Card Driver (PCMCIA)] as the component.

• Install the PC interface card into the host computer.

• Hardware will be acknowledged and driver installation will start automatically.

• Select [Search for a suitable driver for my device (recommended)] for driver installation, and
select [Specify a location] for the location.
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• Specify <Drive>:\DRIVERS\PCMCIA\2000 for the location. <Drive> is the drive name of the
CD-ROM drive.

• Check that E6000 PC Card has been detected and complete driver installation.

When Using the LAN Adapter:

• Log-on as Administrator.

• Install the provided software. Select [E8000 LAN Driver] as the component.

• Connect the LAN adapter to the local network and turn on the LAN adapter.

• Select [SH7055 E8000 Emulator Software]-[Tools]-[LAN Adapter Configuration] from
[Start]-[Programs] and start the LAN Adapter Configuration.

• Set the LAN adapter by LAN Adapter Configuration.

• Turn off the LAN adapter and connect the LAN adapter to the target network and turn on the
LAN adapter. Then LAN adapter must be turned off even when the network is not changed.

Note: When using a LAN adapter that has already been set, it is unnecessary to set it again. Use
LAN Adapter Configuration to define only the host computer. For details on the usage of
the LAN Adapter Configuration, refer to the online help of the LAN Adapter
Configuration.

When Using the USB Adapter:

• Log-on as Administrator.

• Install the provided software. Select [E8000 USB Driver] as the component.

• Install the USB adapter into the host computer.

• Hardware will be acknowledged and the USB adapter will be automatically acknowledged.

• Select [Search for the best driver for your device] for driver installation, and select [Specify a
location] for the location.

• Specify <Drive>:\DRIVERS\USB for the location. <Drive> is the drive name of the CD-ROM
drive.

• Check that E8000/E6000 USB Adapter has been detected and complete driver installation.

2.2.4 PC Interface Board Specifications (ISA Bus Specifications)

A PC interface board (HS6000EII01H, ISA bus specifications) is available for use as the interface
for communications between the emulator and the HDI.  Firstly, the PC interface board must be
inserted to the empty expansion slot.

The PC interface board is a memory-mapped board; the memory area to be used by the PC
interface board must be defined in the emulation memory before the PC interface board is placed
in an unused expansion slot. Otherwise, programs may accidentally use the area of memory
required by the PC interface hardware.
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CAUTION
Be careful not to allocate the PC interface  board to a

  memory area to which other boards have been  allocated.
  If you fail to take care of this point,  correct  operation cannot
  be guaranteed.

When the PC interface board is shipped, the switch settings
are for allocation to the address range from H ’D0000 to
H’D3FFF.

For details on installing the PC interface board, refer to the SH7055 E8000 Emulator User’s
Manual and the Description Notes on Using the PC Interface Board (HS6000EII01H).

Setting Up the PC Interface Board on Windows® 95, Windows® 98, or Windows® 98SE:
Description of setting up a PC interface board (HS6000EII01H) is given below, taking settings
under Windows® 95 as an example.

• Start Windows® 95.

• Click the [My Computer] icon with the right mouse button and select [Properties] from the
pop-up menu.

The [System Properties] dialog box will be displayed.

• Double-click the [Computer] icon in the [Device Manager] panel to open the [Computer
Properties] dialog box.

• Click the [Memory] radio button in the [View Resources] panel to display the memory
resources.

Select one of the address ranges that is not listed in the [Computer Properties] dialog box.  For
example, if you select the range H'D8000 to H'DBFFF, the corresponding switch number will be
6.

Define the memory area so that Windows® 95 does not use this area as follows:

• Click [Memory] in the [Reserve Resources] panel and click [Add…].
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The [Edit Resource Setting] dialog box will be displayed.

• Enter the memory area addresses in [Start value] and [End value] and click [OK].

• Shut down the host computer (do not restart it) and turn off the power switch.

• Power on the host computer.

• Check that the area selected in the [Computer Properties] dialog box are displayed as [System
Reserved] in the list.

The next step prevents the memory area for the PC interface board being accessed by another
program. Modify the CONFIG.SYS file. Use the SYSEDIT program to edit the file.

• Select [Run] from the [Start] menu.

• Type SYSEDIT and click [OK]. The SYSEDIT will start.

When EMM386.EXE is used in the CONFIG.SYS file, the CONFIG.SYS file must be modified.
If the CONFIG.SYS file is not used, or if EMM386.EXE is not used even when the CONFIG.SYS
file is used, go to the next procedure for modifying the SYSTEM.INI file.

• Locate the line in the CONFIG.SYS file that reads:

device=C:\WINDOWS\EMM386.EXE RAM

• Change the line so that it reads as shown below.

device=C:\WINDOWS\EMM386.EXE RAM X=aaaa–bbbb

Here, aaaa is the upper four digits of [Start value] and bbbb is the upper four digits of [End
value]. For example, for the switch set to 6 with memory area H’D8000 to H’DBFFF selected,
you would set the line to read:

device=C:\WINDOWS\EMM386.EXE RAM X=D800–DBFF

• Save the CONFIG.SYS file.

The following is about modifying the SYSTEM.INI file.

• Add the following line to the [386Enh] section in the SYSTEM.INI file:

EMMExclude=aaaa-bbbb

Here, aaaa is the upper four digits of [Start value] and bbbb is the upper four digits of [End
value]. For example, for the switch set to 6 with memory area H’D8000 to H’DBFFF selected,
you would set the line to read:

EMMExclude = D800-DBFF
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• Save the SYSTEM.INI file and exit the SYSEDIT.

• Restart the host computer.

Setting Up the PC Interface Board on Windows NT® 4.0: The description given below is about
setting up the PC interface board (HS6000EII01H) on Windows NT® 4.0.

For the installation of the PC interface board to the ISA bus slot, refer to the manual of your host
computer.
This section describes the general procedure for installing the PC interface board in the host
computer.

Log-on to the host computer as Administrator. Check which upper memory areas have already
been used.

Start Windows NT®4.0.

• Execute [Start]-[Programs]-[Administrative Tools (Common)]-[Windows NT Diagnostics].

• Click the [Memory] button in the [Resource] tab and, in the following form, make a note of
the upper memory areas that have already been used.

• Exit Windows NT®4.0.

• Register the memory area for the PC interface board.  Select one of the memory areas that
correspond to the following PC interface board switch settings, and no other devices can
access the selected memory area.

If the Intel P&P BIOS disk is supplied with the host computer, register the memory area as
follows:

• Start the host computer with the Intel P&P BIOS disk.

• Check the upper memory areas that have already been used, with [View]-[System Resources].

• Add [Unlisted Card] with [Configure]-[Add Card]-[Other...].

• Click [No] in the dialog box displayed because there is no .CFG file.

• Move to the [Memory [hex]] list box in the [Configure Unlisted Card] dialog box.

• Click the [Add Memory...] button to display the [Specify Memory] dialog box.

• Enter a memory area range that is not used by any other device and that corresponds to one of
the PC interface board switch settings.

• Save the file.

• Exit the current setup program.

• Shut down Windows NT® 4.0 and turn off the host computer power switch.

• Turn on the host computer.
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2.3 Installing the System Program

The E8000 system program must be transferred to flash memory in the E8000 emulator station.
The E8000 emulator cannot be used without the E8000 system program.

The system programs are stored in the SYSTEM directory under the HDI installation directory.
Table 2.1 is a list of system programs with descriptions.

Table 2.1 Contents of Emulator System Programs

No. File Name Contents of File

1 E8000.SYS System program for the emulator. Controls the evaluation board
and executes various commands such as emulation. Loaded to
the memory of the emulator at the start of the emulator system
program.

2 SHDCT705.SYS MCU control program. Controls the MCU in the evaluation chip
board. Loaded to the memory of the E8000 emulator at the start
of the emulator system program.

3 SHCNF705.SYS Configuration file to store the MCU operation mode and MAP
information. Loaded with the emulator system program.

4 DIAG.SYS Diagnostic/maintenance program. Loaded to the memory in the
E8000 emulator station for maintenance.

The system program is defined by using a dedicated E8000 system installation tool (hereafter
referred to as ESI). There are two methods for registering the system program: auto installation
and custom installation.

First, auto installation is described below.

• Select [Programs]-[SH7055 E8000 Emulator Software]-[Tools]-[System Install Tool] from the
[Start] menu.
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Figure 2.1   Selecting [System Install] from the [Start] Menu

When the ESI has been initiated, [Select Driver] dialog box will be displayed. Select the driver
that corresponds to the connection between the host computer and the E8000 emulator via
[Driver]. Table 2.2 shows the types of connections and drivers.

Table 2.2 Types of Connections and Drivers

Connecting Form Contents of File

When connecting the E8000 emulator to PC
interface board

Emulator ISA Driver

When connecting the E8000 emulator to
USB adapter

E8000 USB Driver

When connecting the E8000 emulator to
LAN adapter

E8000 LAN Driver

When connecting the E8000 emulator to
PCI interface board

Emulator PCI Card Driver

When connecting the E8000 emulator to PC
interface card

Emulator PC Card Driver

“Link up” appears on the status bar when the ESI has been successfully initiated.

Select the [Auto Install] radio button in the [Select Install] dialog box.  When the [Browse for
Folder] dialog box is displayed, select the director that the system program has been saved.  (The
default directory name is \SYSTEM under the HDI installation directory.)
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Figure 2.2   [Browse for Folder] Dialog Box

When the [OK] button is clicked, the [E8000 Load Files] dialog box is displayed.  Check the
name of the file to be installed.
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Figure 2.3   [E8000 Load Files] Dialog Box

Click the [OK] button.  The system program is registered to the emulator.  The file name that has
been registered on the status bar is displayed.  When the [Cancel] button is clicked, the [Select
Install] dialog box will be returned.

When registration has been completed, the [System Install Completed!!] dialog box is displayed.
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Figure 2.4   [System Install Completed!!] Dialog Box

Click the [OK] button.  Registration of the system program to the emulator is completed and ESI
ends.  Turn the emulator off.

Next, custom installation is described below.

When the [Select Install] dialog box is displayed, select the [Custom Install] radio button.  The
[E8000 Load Files] dialog box is displayed to select the file to be added or changed.
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Figure 2.5   [E8000 Load Files] Dialog Box

Each check box corresponds to the combo box that is located at the right side.  Select the check
box that corresponds to the file to be registered.  Place a cursor in the combo box and press the
[Browse] button.  When the [Browse] button is clicked, a dialog box for selecting the file is
displayed.

Select the file to be registered.  When the selected file is not registered, do not select the check
box.  In this case, the file is displayed in gray and is not registered.

Click the [OK] button.  The system program is registered to the emulator.  The file name that has
been registered on the status bar is displayed.  Then take the same procedure as for auto
installation.  When the [Cancel] button is clicked, the [Select Install] dialog box will be returned.

For error messages that are displayed during ESI operation, refer to the troubleshooting for the
ESI help.  To see the ESI help, select [Programs]-[SH7055 E8000 Emulator Software]-[Tools]-
[System Install Tool Help] from the [Start] menu.
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2.4 Checking the System

The next step is to check that the E8000 emulator and the HDI are initiated correctly.

• Turn on the E8000 emulator after confirming that the S7 and S8 DIP switches of SW1 on the
E8000 emulator are turned on.

• Select [SH7055 E8000 Emulator Software] from the [Start] menu.

Figure 2.6   [Start] Menu



23

The [Select Session] dialog box will be displayed.  Select the target emulator name in the combo
box then click the [OK] button.

Figure 2.7   [Select Session] Dialog Box

When the HDI is started up for the first time, the [Driver Details] dialog box will be displayed.
Use [Driver] to select the right driver for the connected interface (PC interface board, PCI
interface board, PC interface card, USB adapter, or LAN adapter) to click the [Close] button.
Refer to table 2.2, Types of Connections and Drivers. The example below is when the E8000
emulator is to be connected to the PC interface via the ISA bus.

Figure 2.8   [Driver Details] Dialog Box (When Selecting ISA Driver)
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During the HDI initiation, the following messages are shown on the status bar of the HDI window.

Figure 2.9   Status Bar during the HDI Initiation

A message box will be displayed, as shown in figure 5.3, to ask whether to initiate the diagnostic
program when [Diagnostic Test Program] has been selected in the component selection dialog box
during installation. Click the [Yes] button to initiate the diagnostic program. For details, refer to
section 5, Use of Diagnostic Program.

“Link up” appears on the status bar when the HDI has successfully started up.

Figure 2.10   Status Bar at the HDI Initiation Completion
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2.5 Troubleshooting

2.5.1 Connection Error of the PC Interface Board

The HDI displays the following message box when the PC interface board for connecting to the
emulator cannot be detected.

Figure 2.11   PC Interface Board Connection Error Message Box

The following causes can be considered:

• The memory area reserved in the CONFIG.SYS file differs from the setting of the rear-panel
switch of the PC interface board.

• The selected memory area has already been used for another application.

2.5.2 Connection Error of the Emulator

The HDI displays the following message box when the emulator cannot be detected.

Figure 2.12   Emulator Connection Error Message Box
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The following causes can be considered:

• An AC adapter power supply is not connected to the emulator, or the emulator is not switched
on.  Check the power LED of the emulator.

• The PC interface cable is not correctly connected between the PC interface board and the
emulator.
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2.6 Uninstallation

2.6.1 Uninstalling Software

This section describes the procedure for uninstalling software. Be sure to terminate all executing
applications before uninstalling software.

1. Click [Settings]-[Control Panel] from the [Start] menu.

2. Double-click the [Add/Remove Programs] icon.

3. Click [SH7055 E8000 Emulator Software] from the [Install/Uninstalls] tab and double-click
the [Add/Remove…] button.

4. Select [SH7055 E8000 Emulator Software] from the list box and click the [Add/Remove…]
button.

The setup program is executed again to allow the modification, correction, or removal of the
installed applications. Select removal to uninstall applications.

Note: Shared files may be detected during uninstallation. Do not remove shared files if they
might be used by other HDIs. When Windows NT® 4.0 is used, you might be asked
whether you want to remove information registered in the driver’s registry. Do not remove
information registered in the registry, if it might be used by other HDIs. If other HDIs will
no longer start up because of uninstallation, reinstall the other HDIs.

2.6.2 Uninstalling the Acrobat® Reader

Only uninstall the Acrobat® Reader if it is necessary. Click [Settings]-[Control Panel] from the
[Start] menu. Double-click the [Add/Remove Programs] icon. Click [Adobe Acrobat Reader x.x]
from the list box on the [Install/Uninstall] tab page and click the [Add/Remove…] button. Follow
the directions on the screen.
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Section 3 Tutorial

3.1 Introduction

The following describes a sample program for sorting random data in order to introduce the main
functions of the HDI.

The sample program performs the following actions:

• The main function generates 10 pieces of random data to be sorted.

• The sort function sorts the random data in ascending order.

• The change function changes the data in descending order.

Table 3.1 shows the configuration of the sample program.

Table 3.1 Configuration of Sample Program

No. Item Description

1 HEW workspace file* \HEW\HDI5\E8000\7055\TUTORIAL\TUTORIAL.HWS

2 ELF/DWARF2 load module \HEW\HDI5\E8000\7055\TUTORIAL\TUTORIAL\DEBUG
\TUTORIAL.ABS

3 Source file (main program) \HEW\HDI5\E8000\7055\TUTORIAL\TUTORIAL\TUTORIAL.C

Note: The sample program is created using the SuperH RISC engine C/C++ compiler package
(V6.0.0r1).
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3.2 Running the HDI

To execute the HDI, select [SH7055 E8000 Emulator Software] – [Hitachi Debugging Interface]
from the [Start] menu.

Figure 3.1   [Start] Menu
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3.2.1 Selecting the Target Program

When the HDI is initiated, the dialog box for selecting the current session platform is displayed.
Select E8000 SH7055 Emulator.

Figure 3.2   [Select Session] Dialog Box

The target platform can be selected by selecting [New Session…] from the [File] menu.

When the emulator is correctly set up, Link Up is displayed on the status bar and the HDI window
will be displayed. The main functions of the HDI window are given below.
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Figure 3.3   HDI Window

Numbers in figure 3.3 indicate the following:

1. Menu bar

Indicates the access to the HDI commands for the use of the HDI debugger.

2. Toolbar

Contains convenient buttons as shortcuts of menu commands most frequently used.

3. Status bar

Indicates the state of the emulator and progress information about downloading.

4. [Help] button

Activates the context-sensitive help concerning features of the HDI user interface.



33

3.3 Setting up the Emulator

The following MCU conditions must be set up before downloading the program:

• Device type

• Operating mode

• Operating clock

• Execution operating mode

• Memory map

The following describes how to set up the emulator correctly for the tutorial programs.
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3.3.1 Setting the [Configuration] Dialog Box

Select [Configure Platform...] from the [Setup] menu to set configuration. The following dialog
box is displayed:

Figure 3.4   [Configuration] Dialog Box
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Set options as follows:

Table 3.2 Setting the [Configuration] Dialog Box

Page Option Value

CPU operating mode [Mode] Advanced Mode without Internal
ROM (CS0 Area 8-bit bus)

Emulation clock [Clock] Emulator Clock (5 MHz) (using the
emulator clock)

Emulation mode [Emulation
mode]

Normal (normal execution)

[General] page

Memory access
enabled/disabled during
execution [Prohibit R/W on the
fly]

Enabled (no check)

Program counter display
interval [Execution status
display interval]

About 200 ms (default setting)

Timer resolution [The minimum
time to be measured by Go
command execution]

1.6 us (default setting)

User-wait control [Enable user
wait]

Valid (default setting)

Multi-break function [Enable
the multi break of External
probe No. 1]

Invalid (default setting)

[Execution Mode1] page

BREQ signal control [Enable
the BREQ signal input]

Invalid (default setting)

Trigger output control 1 at
break [TRGU Option]

Upper (default setting)[Execution Mode2] page

Trigger output control 2 at
break [TRGB Option]

Upper (default setting)

• Click the [OK] button to set any changes in the configuration.
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3.3.2 Setting the Memory Map

In the next step, allocate the emulation memory for the developing application.

• Select [Memory Mapping Window] from the [View] menu to display the current memory
map.

The [Memory Mapping] window is displayed.

Figure 3.5   [Memory Mapping] Window (Before Setting)



37

The emulator can allocate the optional memory area as one of the following five types:

Table 3.3 Memory Type

Memory Type Description

USER AREA Read-Only Sets the user memory area to be write-protected.

USER AREA Guarded Sets the user memory area to be access-inhibited.

EMULATION AREA Sets the address range of the emulation memory area.

EMULATION Read-Only Sets the emulation memory area to be write-protected.

EMULATION Guarded Sets the emulation memory area to be access-inhibited.

When the [Add] button is clicked, the [Edit Memory Mapping] dialog box is displayed.

Figure 3.6   [Edit Memory Mapping] Dialog Box

For this tutorial, allocate the memory area of addresses ranging from H’00000000 to H’003FFFFF
as an emulation memory area.
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• Set the [From] and [To] edit boxes to H’00000000 and H’003FFFFF, respectively, set the
[Setting] combo box to [EMULATION AREA], and click the [OK] button.

The [Memory Mapping] window will now show the modified ranges.

Figure 3.7   [Memory Mapping] Dialog Box (at Setting)

• Click the close box [X] in the upper-right corner of the [Memory Mapping] window to close
the window.
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3.4 Downloading the Tutorial Program

3.4.1 Downloading the Tutorial Program

Download the ELF/DWARF2 tutorial program.

• Select [Load Program...] from the [File] menu. The [Load Program] dialog box will be
displayed.

• Select the [Browse…] button. The [Open] dialog box will be displayed.

• Select the file TUTORIAL.ABS and click the [Open] button.

• Click the [Open] button in the [Load Program] dialog box.

Figure 3.8   [Load Program] Dialog Box
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When the file has been loaded, the following dialog box showing the loaded program address is
displayed.

Figure 3.9   [HDI] Dialog Box

• Click the [Open] button to continue.
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3.4.2 Displaying the Source Program

The [Source] window allows the user to debug a program at the source level, such as displaying
the C/C++-language source program, setting the breakpoints, executing the program, and selecting
variables in the [Source] window, so that the user can see a list of the C/C++ program alongside
the machine code as the user debugs. To do this, the C/C++ source file that corresponds to the
object file needs to be read.

• Select [Source] from the [View] menu. The [Open] dialog box will be displayed.

Figure 3.10   [Open] Dialog Box
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• Select [tutorial.c] and click the [Open] button.  The [Source] window is displayed.

• If necessary, select the [Font] option from the [Customize] submenu on the [Setup] menu to
select a font and size suitable for the host computer.

Figure 3.11   [Source] Window (Displaying the Source Program)
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3.5 Setting the Software Breakpoint

A breakpoint is one of the easy debugging functions.

The [Source] window provides a very simple way of setting a breakpoint at any point in a
program. For example, to set a breakpoint at the sort function call:

• Double-click the [BP] column on the line containing the sort function call. The word Break
will be displayed on the line containing the sort function to show that a software breakpoint is
set at that address.

Figure 3.12   [Program] Window (Setting a Software Breakpoint)

Note: The software breakpoint cannot be set in the ROM area. (It can be set in the internal ROM
area.)
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3.6 Executing the Program

• To execute the program, select [ResetGo] from the [Run] menu, or click the [ResetGo] button
on the toolbar.

Figure 3.13   [ResetGo] Button

The program will be executed up to the breakpoint that has been inserted, and a statement will be
highlighted in the [Source] window to show the position that the program has halted.

Figure 3.14   [Source] Window (Break State)
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The user can see the cause of the last break in the [System Status] window.

• Select [Status Window] from the [View] menu. The [System Status] window is displayed.

• Select the [Platform] sheet of the [System Status] window.

Figure 3.15   [System Status] Window

The [Cause of last break] line shows that the cause of the break is the breakpoint.
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3.7 Reviewing Breakpoints

The user can see all the breakpoints set in the program in the [Breakpoints] window.

• Select [Breakpoints] from the [View] menu.

Figure 3.16   [Breakpoints] Window

The [Breakpoints] window also allows the user to set breakpoints, define new breakpoints, and
delete breakpoints.

• Close the [Breakpoints] window.
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3.8 Viewing Memory

The user can view the contents of a memory block in the [Memory] window. For example, to
view the memory corresponding to the main function in word size:

• Select [Memory...] from the [View] menu. The [Open Memory Window] dialog box is
displayed.

•  Enter main  in the [Address] edit box, and set the [Format] combo box as [Word].

Figure 3.17   [Open Memory Window] Dialog Box

• Click the [OK] button.  The [Memory] window showing the specified area of memory is
displayed.

Figure 3.18   [Word Memory] Window
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3.9 Watching Variables

As the user steps through a program, it is possible to watch the values of variables used in the
program. For example, set a watch on the long-type array a declared at the beginning of the
program, by using the following procedure:

• Click the left of displayed array a in the [Source] window to position the cursor.

• Click the [Source] window with the right mouse button, and select [Instant Watch...] from a
pop-up menu.

The following dialog box will be displayed.

Figure 3.19   [Instant Watch] Dialog Box

• Click the [Add Watch] button to add a variable to the [Watch] window.

Figure 3.20   [Watch] Window (Displaying the Array)
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The user can also add a variable to the [Watch] window by specifying its name.

• Click the [Watch] window with the right mouse button and select [Add Watch] from the pop-
up menu.

The following dialog box will be displayed.

Figure 3.21   [Add Watch] Dialog Box

• Input variable max and click the [OK] button.
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The [Watch] window will now also show the long-type variable max.

Figure 3.22   [Watch] Window (Displaying the Variable)

Double-click the + symbol to the left of any variable in the [Watch] window to expand the
variable and watch all the elements in the array.

Figure 3.23   [Watch] Window (Displaying Array Elements)
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3.10 Stepping Through a Program

The HDI provides a range of step menu commands that allow efficient program debugging.

Table 3.4 Step Option

Menu
Command Description

Step In Executes each statement within a function, or one instruction of the assembly
language. (Stops execution at the top of the function call.)

Step Over Executes a function in a single step, or one instruction of the assembly
language. (A function call is executed in one step.)

Step Out Steps out of a function, and stops at the next statement that called the function
in the program.

Step… Steps the specified counts repeatedly at a specified rate.
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To demonstrate program stepping, confirm that the sort function statement at address H’00003036
has been executed.

Figure 3.24   [Source] Window (Step Execution)
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3.10.1 Executing [Step In] Command

The [Step In] steps into the called function and stops at the first statement of the called function.

• To step through the sort function, select [Step In] from the [Run] menu, or click the [Step In]
button in the toolbar.

Figure 3.25   [Step In] Button

Figure 3.26   [Source] Window (Step In)

• The highlighted line moves to the first statement of the sort function in the [Source] window.
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3.10.2 Executing [Step Out] Command

The [Step Out] command steps out of the called function and stops at the next statement of the
sort calling statement.

• To step out of the sort  function, select [Step Out] from the [Run] menu, or click the [Step
Out] button in the toolbar.

Figure 3.27   [Step Out] Button

Figure 3.28   [Source] Window (Step Out)

• The data of variable a displayed in the [Watch] window is sorted in ascending order.
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• To execute two steps, use [Step In] twice.

Figure 3.29   [Source] Window (Step Out -> Step In)

• The value of max displayed in the [Watch] window is changed to the maximum data value.
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3.10.3 Executing [Step Over] Command

The [Step Over] executes a function call as a single step and stops at the next statement of the
main program.

• To demonstrate the [Step Over] command, execute two steps to reach the change function
statement.

Figure 3.30   [Source] Window (Before Step Over Execution)
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To step through all statements in the change  function at a single step, select [Step Over] from
the [Run] menu, or click the [Step Over] button in the toolbar.

Figure 3.31   [Step Over] Button

Figure 3.32   [Source] Window (Step Over)

When the last statement of the change function is executed, the data of variable a, which is
displayed in the [Watch] window, is sorted in descending order.
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3.11 Displaying Local Variables

The user can display local variables in a function using the [Locals] window. For example, the
local variables in the main function, which declares five local variables: a, j, i, min, and max, will
be examined.

• Select [Local Variable Window] from the [View] menu.

The [Locals] window is displayed.  Initially, the [Locals] window is empty because local variables
have not yet been declared.

• Select [Step In] from the [Run] menu to execute a single step.

The [Locals] window will now show the local variables and their values.

Figure 3.33   [Locals] Window

• Double-click the + symbol to the left of array a in the [Locals] window to display the elements
of array a.

• Refer to the elements of array a before and after the execution of the sort function, and
confirm that random data is sorted in ascending or descending order.
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3.12 Setting the Hardware Break Conditions

The emulator has powerful hardware break functions.  In the HDI, these hardware break
conditions can be set by using dialog boxes.  The dialog boxes for setting hardware break
conditions, and the corresponding break conditions, are described below.

Table 3.5 Dialog Boxes for Setting Hardware Break Conditions

Function

Dialog Box

Address
Bus
Condition
(Address)

Data Bus
Condition
(Data)

Bus
State
Condition
(Bus
State)

External
Probe
Signal
Condition
(Probe)

Interrupt
Signal
Condition
(Interrupt)

Satis-
faction
Count
(Count)

DELAY
Condition
(Delay)*3

[Break Condition
UBC1] dialog box

O O O X X O X

[Break Condition
UBC2/3/4] dialog
box

O O O X X X X

[Break Condition A]
dialog box*2

O O O O O X X

[Break Condition B]
dialog box*2

O O O O O O O

[Break Condition C]
dialog box*2

O X O X X X X

Notes: 1. O: Can be set in the dialog box.

X: Cannot be set in the dialog box.

2. Eight break condition points can be set independently in each of the [Break Condition
A/B/C] dialog boxes.

3. Only Break Condition B7 can be set for the DELAY condition in the [Break Condition B]
dialog box.
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Table 3.6 Main Break Conditions

Break Condition Description

Address bus condition (Address) Breaks on a match of the MCU address bus value.

Data bus condition (Data) Breaks on a match of the MCU data bus value.  Byte,
word, or longword can be specified as the access data
size and bus position.

Bus state condition (Bus State) There are two bus state condition settings:

Read/write condition: Breaks when the MCU RD or
RDRW signal level matches the specified condition.

Bus state condition: Breaks when the operating state in
the MCU memory access cycle, DMA cycle, or vector
fetch cycle matches the specified condition.

External probe signal condition (Probe) Breaks when an external probe signal (PRB1 to PRB4)
level matches the specified condition.

Interrupt signal condition (Interrupt) Breaks when the NMI signal or an external interrupt
signal (IRQ0 to IRQ7) level matches the specified
condition.

Satisfaction Count (Count) Breaks when all the above conditions have been
satisfied the number of times specified in this condition.
(A maximum count of 65,535 can be specified.)

DELAY condition (Delay) Breaks when all the above conditions have been
satisfied and the bus cycles specified in this condition
have been executed.  (A maximum of 32,767 bus cycles
can be specified.)
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An example is given below in which the address bus condition and read cycles for state condition
are set in Break Condition A as hardware break conditions.

• Select [Breakpoints] from the [View] menu.  The [Breakpoints] window is displayed.

• When the right button of the mouse is clicked in the [Breakpoints] window, a pop-up menu
appears.

• Click the [Add] button.

Figure 3.34   [Breakpoints] Window (Before Hardware Break Condition Setting)

The [Break] dialog box is displayed.  For hardware break conditions, the [Break] dialog box pages
required for the setting must be selected.

• Select [Condition A] to display the [Condition A] page.
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Figure 3.35   [Condition A] Page ([Break] Dialog Box)

Up to eight breakpoints can be set independently for the Break Condition A (B, C) hardware break
conditions.  In the example, one point is set for the Break Condition A hardware break conditions.

• Highlight the first point in the [Condition] list box.

• Click the [Edit...] button.  The [Break Condition A1] dialog box is displayed.

• Make the [Don’t Care] check box in the [Address] page invalid.

• Select the [Address] radio button and input address H'3058 as the value in the [Start] edit
box.
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Figure 3.36   [Address] Page ([Break Condition A1] Dialog Box)

• Select [Bus State] to display the [Bus State] page.

• Select the [Read] radio button.
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Figure 3.37   [Bus State] Page ([Break Condition A1] Dialog Box)

• Click the [OK] button.

• The [Break] dialog box is displayed, and the first point display in the [Condition] list box
changes from ‘Empty’ to ‘address H’3058 direction read’.
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Figure 3.38   [Break] Dialog Box (After Hardware Break Condition Setting)

• Click the [Close] button.
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The newly set hardware breakpoint is displayed in the [Breakpoints] window.  With this setting,
‘Break Condition A1:Enable address H’3058 direction read’ is displayed in [Type] in the
[Breakpoints] window.

This completes the setting of the Break Condition A1 hardware break conditions. When the
program is executed, a break will occur when address H'3058 is accessed in a read cycle.

Figure 3.39   [Breakpoints] Window ([Break Condition A] Setting)
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3.13 Setting the Sequential Break Conditions

The emulator has powerful sequential break functions.  In the HDI, these sequential break
conditions can be set by using dialog boxes.  The dialog boxes for setting sequential break
conditions, and the corresponding sequential break functions, are described below.

Table 3.7 Dialog Boxes for Setting Sequential Break Conditions

Function

Dialog Box

Address
Bus
Condition
(Address)

Data Bus
Condition
(Data)

Status
Condition
(Status)

External
Probe
Condition
(Probe)

Interrupt
Condition
(Interrupt)

Satis-
faction
Count
(Count)

DELAY
Condition
(Delay)

[Break Condition
UBC1] dialog box

O O O X X O X

[Break Condition
UBC2] dialog box

O O O X X X X

[Break Condition
UBC3] dialog box

O O O X X X X

[Break Condition
UBC4] dialog box

O O O X X X X

[Break Sequence]
dialog box

O X X X X X X

Note: “O” indicates that relevant functions can be set in relevant dialog boxes, and “X” indicates
that they cannot be set.



68

Table 3.8 Main Sequential Break Functions

Sequential Break Function
Description

Break Sequence A sequential break function using software breaks.

Up to seven address points and one reset point address can be
set.  When all the set points are passed in sequence, the program
is stopped.

Break Condition UBC1,2,3,4 Sequential break functions by combining satisfaction conditions of
hardware break conditions, i.e., Break Condition UBC1, 2, 3 and
4.  Combinations of the following satisfaction conditions can be
selected:

• Program execution is halted when conditions are satisfied in
the order of UBC2 and UBC1. (Sequential break mode UBC 2
-> 1)

• Program execution is halted when conditions are satisfied in
the order of UBC3, UBC2 and UBC1. (Sequential break mode
UBC 3 -> 2 -> 1)

• Program execution is halted when conditions are satisfied in
the order of UBC4, UBC3, UBC2 and UBC1. (Sequential break
mode UBC 4 -> 3 -> 2 -> 1)

One point of reset point address can be set to the respective
combinations.

After passing the reset point addresses, these functions make sequential break conditions already
passed so far invalid and resume checking break conditions from the first one.
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As an example of a sequential break function, the case when sequential break mode UBC2 -> 1 is
set is described below.

Before executing the program, change the [Configuration] dialog box.  When not changing it, the
sequential break does not function.

• Select [Configure Platform...] from the [Setup] menu, and the [Configuration] dialog box will
appear.

• Select [Sequential break mode UBC2 -> 1] from the [Emulation Mode] combo box.

Figure 3.40   [Configuration] Dialog Box (When Sequential Break is Set)
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An example is given below in which Break Condition Sequence is used as the sequential break
function.  Set break conditions as follows:

Break condition 1: A break is executed when address H’3056 is accessed in a read cycle. (Break
Condition UBC1)

Break condition 2:  A break is executed when address H’3046 is accessed in a read cycle. (Break
Condition UBC2)

After Break Condition 2 is satisfied and Break Condition 1 is satisfied in succession, a program
being executed will stop.  Then, set the sequential break conditions.

• Select [Breakpoints] from the [View] menu.

The [Breakpoints] window is displayed.

• When the right button of the mouse is clicked in the [Breakpoints] window, a pop-up menu
appears. Select [Delete All] and cancel all the breakpoints that have been set.

• Display a pop-up menu again and select [Add…]. The [Break] dialog box is displayed.

Figure 3.41   [Breakpoints] Window (Before Sequential Break Conditions Setting)

The [Break] dialog box appears.  To set sequential break conditions, select [Condition UBC] and
display the [Condition UBC] page.
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Figure 3.42   [Break] Dialog Box ([Break Condition UBC] Page)
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Set Break Condition 2 of the sequential break conditions to Break Condition UBC2 and set Break
Condition 1 to Break Condition UBC1.

• Highlight the second line in the [Condition] list box.

• Click the [Edit] button.

The [Break Condition UBC2] dialog box will appear.

• Make the [Don’t Care] check box in the [Address] page invalid.

• Select the [Address] radio button and enter the address H’3046  as the value in the [Start] edit
box.

Figure 3.43   [Break Condition UBC2] Dialog Box (Condition 2 [Address] Page)
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• Select [Bus State] to display the [Bus State] page.

• Select [Read] radio button.

Figure 3.44   [Break Condition UBC2] Dialog Box (Condition 2 [Bus State] Page)
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• Click the [OK] button.

• The [Break] dialog box is displayed, and the second point display in the [Condition] list box
changes from Empty to address H’3046 direction read.

Figure 3.45   [Break] Dialog Box (After [Break Condition UBC2] Condition Setting)
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This completes the setting of break condition 2.  Next, set break condition 1 as follows:

• Highlight the first point in the [Condition] list box.

• Click the [Edit...] button.

The [Break Condition UBC1] dialog box is displayed.

The setting can then be made in the same way as for break condition 1.

• After setting break conditions 1 and 2, click the [Close] button.

Break Condition UBC1 and Break Condition UBC2 are displayed in [Type] in the [Breakpoints]
window.

Figure 3.46   [Breakpoints] Window (After Sequential Break Condition Setting)

• Click the [ResetGo] button.

The program is executed up to the conditions of Break Condition UBC1 and comes to a halt.
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Figure 3.47   [Program] Window at Execution Halt (Sequential Break)

The contents of the [System Status] window are as follows:

Figure 3.48   Contents of [System Status] Window (Sequential Break)
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3.14 Using the Trace Buffer

3.14.1 Displaying the Trace Buffer

Using the trace buffer, it is possible to verify execution results upstream of the MCU cycles.

• Select [Trace] from the [View] menu to open the [Trace] window.

• If necessary, adjust the column width by dragging the column divider beside the label
immediately below the title bar.

Figure 3.49   [Trace] Window (Free Trace Results)
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3.14.2 Setting the Trace Filter

In a free trace, the [Trace] window displays all the MCU cycles.  By setting the specific search
condition, it is possible to display only the trace contents that match the search condition in the
[Trace] window.

Table 3.9 Main Trace Search Conditions

Break Condition Description

Address bus condition (Address) Searches for an item that matches the MCU address
bus value.

Data bus condition (Data) Searches for an item that matches the MCU data bus
value.  Access data size (byte, word, or longword) and
data bus location can be specified.

Bus state condition (Bus & Area) There are three bus state condition settings:

Read/write condition: Searches for an item for which the
MCU RD or RDRW signal level matches the specified
condition.

Bus state condition: Searches for an item for which the
conditions of MCU memory access cycle, DMA cycle, or
vector fetch cycle match the specified condition.

Area condition: Searches for an item for which the
memory space accessed in an MCU bus cycle matches
the specified condition.

External probe signal condition
(Probe)

Searches for an item for which an external probe signal
(PRB1 to PRB4) level matches the specified condition.

Interrupt signal condition (Interrupt) Searches for an item for which the levels of the NMI
signal, external interrupt signals (IRQ0 to IRQ7), and the
RESET signal matches the specified condition.

Time condition (Time) Searches for an item for which the time stamp value or
range matches the specified condition.

Click the right mouse button on the [Trace] window, and select [Filter…] from the pop-up menu.

The [Trace Filter] dialog box then appears.
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The filter conditions that limit the cycles to be displayed in the trace buffer can then be set.

• Select the [Pattern] radio button in [Type].

Figure 3.50   [General] Page ([Trace Filter] Dialog Box)

• Select [Address] to display the [Address] page.
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• Clear the [Don’t Care] check box in the [Address] page.

• Select [Address] and input address H’3042 as the value in the [Start] edit box.

Figure 3.51   [Address] Page ([Trace Filter] Dialog Box)

• Select [Bus & Area] to display the [Bus & Area] page.
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• Select the [Read] radio button.

Figure 3.52   [Bus & Area] Page ([Trace Filter] Dialog Box)

• Click the [OK] button to save the trace filter.

Figure 3.53   [Trace] Window (Trace Filter Results)
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3.15 Trace Acquisition Condition Setting

The emulator has powerful realtime trace functions.  Trace information for up to 131,070 bus
cycles can be acquired.  In the HDI, trace acquisition conditions can be set by using dialog boxes.
The dialog boxes for setting trace acquisition conditions and the corresponding trace acquisition
conditions are described below.

Table 3.10 Dialog Boxes for Setting Trace Acquisition Conditions

Function

Dialog Box
Subroutine
Trace Range Trace Trace Stop

Subroutine
Range Trace

[Trace Condition A] dialog box X O O X

[Trace Condition B] dialog box O O O O
[Trace Condition C] dialog box O O O X

Note: O: Can be set in the dialog box.
X: Cannot be set in the dialog box.
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Table 3.11 Main Trace Acquisition Conditions

Trace Acquisition Condition Description

Free trace Acquires trace information continuously from the start of
execution of the user program until the program breaks.

If Trace Conditions A,B,C is not set, this mode is entered.

Subroutine trace Performs trace acquisition of instructions or operand
accesses between the start address and end address of the
specific subroutine with Trace Condition B,C.

Range trace Performs trace acquisition only for places where the
condition specified by Trace Condition A,B,C is satisfied.
Specifiable conditions are:

Address bus condition

Data bus condition

Read/write condition

Bus state condition (DMA cycle, execution cycle, and vector
fetch cycle)

System control signal (BREQ)

External probe condition

Trace stop Stops trace acquisition when the condition specified by Trace
Condition A,B,C is satisfied.  Specifiable conditions are:

Address bus condition

Data bus condition

Read/write condition

Bus state condition (DMA cycle, execution cycle, vector fetch
cycle)

System control signal (BREQ)

External probe condition

DELAY condition

Subroutine range trace Performs trace acquisition only for places where a subroutine
instruction and an operand that have been specified by Trace
Condition B are accessed, and that the condition is satisfied.

An example is given below in which trace stop mode (in which address bus condition and read
cycles for bus state condition are set) is selected for Trace Condition A as the trace acquisition
condition.

• Click the right mouse button on the [Trace] window.  The pop-up menu is displayed.
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• Select [Acquisition] from the pop-up menu to display the [Trace Acquisition] dialog box.

Figure 3.54   [Trace Acquisition] Dialog Box

For trace acquisition conditions, the [Trace Acquisition] dialog box pages required for the setting
must be selected.
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• Select [Condition A] to display the [Condition A] page.

Figure 3.55   [Condition A] Page ([Trace Acquisition] Dialog Box)
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• Highlight the first point in the [Condition] list box.

• Click the [Edit] button.

• The [Trace Condition A1] dialog box is displayed.

Figure 3.56   [General] Page ([Trace Condition A1] Dialog Box)

• Select [Trace Stop] radio button as [Mode] in the [General] page.

• Select [Address] to display the [Address] page.

• Clear the [Don’t Care] check box in the [Address] page.

• Select the [Address] radio button and input H’3046  as the value in the [Start] edit box.
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Figure 3.57   [Address] Page ([Trace Condition A1] Dialog Box)
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• Select [Bus State] to display the [Bus State] page.

• Select [Read] radio button.

Figure 3.58   [Bus State] Page ([Trace Condition A1] Dialog Box)

• Click the [OK] button.

• The [Trace Acquisition] dialog box is displayed, and the first point display in the [Condition]
list box changes from ‘Empty’ to ‘type stop address H’3046 direction read’.
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Figure 3.59   [Condition A] Page ([Trace Acquisition] Dialog Box)

This completes the setting of the Trace Condition A1 trace acquisition condition.  When the
program is executed, trace acquisition will stop when address H’3046 is accessed in a read cycle.
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3.16 Saving the Session

Saving the present debugging session before quitting will allow debugging to be resumed from the
same state in the next session.

Select [Exit] from the [File] menu to exit the HDI.  At this time, a window for specifying the file
name is displayed.  Input the session file name in the window and click the [OK] button.
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3.17 What Next?

This tutorial has described the major features of the emulator and the use of the HDI.

Sophisticated debugging can be carried out by using the emulator in combination with the
emulation tools it offers.  This provides for effective investigation of hardware and software
problems by accurately isolating the conditions under which such problems arise.

Further details on the use of the HDI can be found in the Hitachi Debugging Interface User’s
Manual on the CD-R.
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Section 4   Function

4.1 Windows and Dialog Boxes

Table 4.1 shows the SH7055 E8000 HDI-specific windows and dialog boxes.  For more
information, see the online-help.  To see the online-help, select [Index] in the [Help] menu, or
click [Help] button.  Also the related commands in "The E8000 emulator user’s manual" are
described in it.

Table 4.1 List of Windows and Dialog boxes in the SH7055 E8000 HDI

Category
Name of Window and
Dialog box Description Related E8000 commands

Emulation
condition

[System Status] window It displays the set-up
condition and the program
execution time of the
emulation-associated
functions in the emulator.

CLOCK, EXECUTE_MODE,
GO, MODE

[Configuration] dialog box It sets the emulation
condition in the emulator.

CLOCK, EXECUTE_MODE,
GO, MODE

Break
condition

[Breakpoint] window It lists the all break
conditions having been set
up.

BREAK,
BREAK_SEQUENCE,
BREAK_CONDITION_A,
BREAK_CONDITION_B,
BREAK_CONDITION_C,
BREAK_CONDITION_UBC

[Break] dialog box It displays the set-up state
of each break condition.

BREAK,
BREAK_SEQUENCE,
BREAK_CONDITION_A,
BREAK_CONDITION_B,
BREAK_CONDITION_C,
BREAK_CONDITION_UBC

[Breakpoint] dialog box It can set up to 256 software
breakpoints.

BREAK
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Table 4.1 List of Windows and Dialog boxes in the SH7055 E8000 HDI (cont)

Category
Name of Window and
Dialog box Description Related E8000 commands

Break
condition

[Break Sequence] dialog
box

It can set the software
sequential break with up to
seven passing points and
one reset point.

BREAK_SEQUENCE

[Break Condition A]
dialog box
[Break Condition B]
dialog box
[Break Condition C]
dialog box

Each can set up to eight
hardware break conditions.

BREAK_CONDITION_A,
BREAK_CONDITION_B,
BREAK_CONDITION_C

[Break Condition UBC]
dialog box

It can set up to four UBC
hardware break conditions.

BREAK_CONDITION_UBC

[Break Condition UBC
Reset] dialog box

It can set a reset point of a
sequential break with UBC.

BREAK_CONDITION_UBC

Trace
condition

[Trace] window It displays the contents of
the Trace buffer.

TRACE, TRACE_SEARCH,
TRACE_CONDITION_A,
TRACE_CONDITION_B,
TRACE_CONDITION_C,
TRACE_MODE

[Trace Acquisition]
dialog box

It sets trace acquiaition
conditions and displays the
setting state.

TRACE_CONDITION_A,
TRACE_CONDITION_B,
TRACE_CONDITION_C

[Trace Condition A]
dialog box
[Trace Condition B]
dialog box
[Trace Condition C]
dialog box

Each can set up to eight
acquisition condition of the
trace information.

TRACE_CONDITION_A,
TRACE_CONDITION_B,
TRACE_CONDITION_C

[Trace Filter] dialog box It only displays the trace
result which matches the
condition having been set
up, among the results
displayed in the [Trace]
window.

TRACE_SEARCH

[Trace Find] dialog box It can search the trace
result which matches the
condition having been set
up, among the trace results
displayed in the [Trace]
window.

TRACE_SEARCH
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Table 4.1 List of Windows and Dialog boxes in the SH7055 E8000 HDI (cont)

Category
Name of Window and
Dialog box Description Related E8000 commands

Memory
map

[Memory Mapping] window It can display and edit the
information about the
emulation memory
allocation.

MAP

[Edit Memory Mapping]
dialog box

It can set and modify the
information about the
emulation memory
allocation.

MAP
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4.2 Command Descriptions

The SH7055 E8000 HDI-specific commands are shown in table 4.2.  For more information, see
the online-help.  To see the online-help, select [Index] in the [Help] menu, or execute the HELP
command from the [Command Line] window.

Example

To open the online-help related to the BREAKPOINT command:

help BREAKPOINT (RET)
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Table 4.2 SH7055 E8000 HDI Commands

No Command Abb. Function
Related E8000
Commands

1 BKGRND_INT BI Sets and displays the user
interrupt receive function during
a command-wait state.

BACKGROUND_
INTERRUPT

2 BREAKCONDITION_
CLEAR

BCC Clears hardware breakpoints
(break conditions) that have
been set.

BREAK_CONDITION_
A,B,C

3 BREAKCONDITION_
DISPLAY

BCD Displays hardware breakpoints
(break conditions) that have
been set.

BREAK_CONDITION_
A,B,C

4 BREAKCONDITION_
ENABLE

BCE Enables or disables hardware
breakpoins (break conditions)
that have been set.

BREAK_CONDITION_
A,B,C

5 BREAKCONDITION_SET BCS Sets hardware breakpoints
(break conditions) that have
been set.

BREAK_CONDITION_
A,B,C

6 BREAKSEQUENCE_
CLEAR

BSC Clears software sequential
breakpoints that have been set.

BREAK_SEQUENCE

7 BREAKSEQUENCE_
DISPLAY

BSD Displays software sequential
breakpoints that have been set.

BREAK_SEQUENCE

8 BREAKSEQUENCE_
ENABLE

BSE Enables or disables software
sequential breakpoints that have
been set.

BREAK_SEQUENCE

9 BREAKSEQUENCE_SET BSS Sets software sequential
breakpoints.

BREAK_SEQUENCE

10 BREAKPOINT BP Sets software breakpoints. BREAK

11 BREAKPOINT_CLEAR BC Clears software breakpoints that
have been set.

BREAK

12 BREAKPOINT_DISPLAY BD Displays software breakpoints
that have been set.

BREAK

13 BREAKPOINT_ENABLE BE Enables or disables software
breakpoints that have been set.

BREAK
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Table 4.2 SH7055 E8000 HDI Commands (cont)

No Command Abb. Function
Related E8000
Commands

14 CLOCK CK Selects a CLOCK signal used by
the SH7055.

CLOCK

15 COVERAGE_CLEAR CVC Initialize the coverage trace. SET_COVERAGE

16 COVERAGE_DISPLAY CVD Display the result of coverage
trace.

DISPLAY_COVERAGE

17 COVERAGE_SET CVS Display the range of coverage
trace.

SET_COVERAGE

18 DEVICE_TYPE DE Displays the MCU type currently
selected.

None

19 END END Returns to a user program
execution state when the
emulator enters the parallel
mode due to trace condition
satisfaction.

END

20 EXECUTION_MODE EM Sets debugging conditions
during user program execution.

EXECUTE_MODE

21 GO_OPTION GP Sets the emulation mode during
user program execution.

GO

22 ID ID Displays an emulator type and a
version number.

ID

23 MAP_SET MS Sets emulator memory-map. MAP

24 MODE MO Selects emulator mode. MODE

25 MOVE_TO_RAM MR Stores a user program on ROM
into RAM.

MOVE_TO_RAM

26 PERFORMANCE_
ANALYSIS

PA Displays program execution
state.

PERFORMANCE_
ANALYSIS1 to 8

27 PERFORMANCE_CLEAR PC Clears performance conditions
that have been set.

PERFORMANCE_
ANALYSIS1 to 8

28 PERFORMANCE_SET PS Sets performance conditions. PERFORMANCE_
ANALYSIS1 to 8

29 STATUS STS Displays emulator state
information.

None
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Table 4.2 SH7055 E8000 HDI Commands (cont)

No Command Abb. Function
Related E8000
Commands

30 TRACEACQUISITION_
CLEAR

TAC Clears trace conditions that have
been set.

TRACE_CONDITION_
A,B,C

TRACE_SEQUENCE

31 TRACEACQUISITION_
DISPLAY

TAD Displays trace conditions that
have been set.

TRACE_CONDITION_
A,B,C

TRACE_SEQUENCE

32 TRACEACQUISITION_
SET

TAS Sets trace conditions that
acquire trace information.

TRACE_CONDITION_
A,B,C

TRACE_SEQUENCE

33 TRACE_DISPLAY TD Display the acquisition of trace
information.

TRACE

34 TRACE_MODE TM Sets the trace information
acquisition mode.

TRACE_MODE

35 TRACE_SEARCH TS Searches for information
corresponding to acquired trace
information.

TRACE_SEARCH

36 UBC_CLEAR UBC Clears UBC breakpoints that
have been set.

BREAK_CONDITION_
UBC

37 UBC_DISPLAY UBD Displays UBC breakpoints that
have been set.

BREAK_CONDITION_
UBC

38 UBC_ENABLE UBE Enables or disables UBC
breakpoints that have been set.

BREAK_CONDITION_
UBC

39 UBC_SET UBS Sets UBC breakpoints. BREAK_CONDITION_
UBC
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Section 5   Use of Diagnostic Program

5.1 Diagnostic Program Operation

An E8000 emulator diagnostic program can be used on the HDI.  The installation procedure and
operating details of diagnostic program are given in the SH7055 E8000 Emulator Diagnostic
Program Operation Manual.  This section describes how to run the diagnostic program on the
HDI.

5.1.1 Diagnostic Program Installation on the HDI

To use the diagnostic program, the [Yes] button must be clicked in the dialog box displayed when
installing the HDI in order to install the diagnostic program.

Figure 5.1   HDI Installation Dialog Box

5.1.2 TARGET.INI File Setting

In HDI installation, a file named TARGET.INI is created.  This file contains resource information
indicating whether or not the diagnostic program is to be started when the HDI is activated.

[E8000 HDI TARGET]

Diagnostic Program=Y

Figure 5.2   Example of TARGET.INI File Display

If the diagnostic program is to be run when the HDI is activated, set the “Diagnostic Program”
resource information in the TARGET.INI file as follows:

Diagnostic Program=Y

Diagnostic Program=Y is set in the default TARGET.INI file.
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If the diagnostic program is not to be run, change the setting as follows:

Diagnostic Program=N

5.1.3 Diagnostic Program Start-Up

When the HDI is activated, the following dialog box is displayed.

Figure 5.3   Diagnostic Program Start-Up Confirmation Dialog Box

When the [Yes] button is clicked, the diagnostic program is started and the following window is
displayed.

Figure 5.4   Diagnostic Program Start-Up Window
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• Display area

Displays the diagnostic program test results.

• [COMMAND] edit box

For input of a diagnostic program operation command.

• [STOP] button

Stops the diagnostic program test and switches to the diagnostic program operation command
input mode.

• [END] button

Terminates the diagnostic program and activates the HDI.
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5.1.4 Diagnostic Program Termination

To terminate the diagnostic program, either click the [END] button or else click the [STOP]
button to stop the test and then enter Q in the [COMMAND] edit box.

Figure 5.5   Diagnostic Program Termination

Note: The diagnostic program can only be terminated when waiting for user input.
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Section 6   Error Messages

6.1 Error Messages

The HDI outputs error messages to notify the user of operating errors.  The error messages output
by the HDI are shown in table 6.1.

Table 6.1 Error Messages

Message Cause and Countermeasure

Can not set target configuration
(Clock mode option)

A mode in which the emulator is not supported has been
selected in [Clock] in the [Configuration] window.

Can not set target configuration
(CPU mode option)

A mode in which the emulator is not supported has been
selected in [CPU mode] in the [Configuration] window.

Can not set target configuration
(Execution mode option)

A mode in which the emulator is not supported has been
selected in [Execution mode] in the [Configuration] window.

Cannot use command when user
program executing

Command line input has been performed when a command
cannot be issued to the emulator.  Wait for processing to
finish.

Command timeout The HDI has timed out because no response has been
received from the emulator after the HDI issued a
command.  Terminate the HDI, power on the emulator, and
restart the HDI.

Emulator command send/receive
check error

Communication with the emulator was not performed
correctly on HDI activation.  Terminate the HDI, power on
the emulator, and restart the HDI.  If the illegal
communication is not corrected, inform a Hitachi sales
representative or agency of the situation.

Emulator firmware not ready “EMULATOR FIRMWARE NOT READY” is output from the
emulator.  Terminate the HDI and check whether the
emulator is functioning normally.

Emulator timeout A timeout message has been detected from the emulator.
Terminate the HDI and check whether the emulator is
functioning normally.

Failed to find matching trace record The HDI has failed in searching for trace information.  This
message is also output when there is no trace information.
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Table 6.1 Error Messages (cont)

Message Cause and Countermeasure

Hardware register read/write check
error

An error was detected when the emulator hardware
registers were tested.  Check whether the emulator is
functioning normally.

Invalid version number in target
configuration

The current e8705532.dll version is different from the
version when the session file was created.  Invalid the low
version number of session file.

System ID error An emulator different form the SH7055 E8000 emulator is
connected.  Check the SH7055 E8000 emulator connection
to the host computer.

Target internal error Commands cannot be issued to the emulator.  Wait for
processing to finish.

User system not ready “No clock” has been detected.  The HDI is terminated.
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